
President’s 
Message                                                 

Linda Volin 

The World in Black and White                                  

Today‘s world is dominated by color¸ but the 
creative person can uniquely capture 
surroundings in black, white and tones of 
gray.   

Goals for creating black and white 
photographs should be that of obtaining 
crisp images with much contrast.  Through 
monochromatic images the photographer 
can present viewers with abstract, 
interpretive views of the real world.  
Photographs of serious people in serious 
situations can be most effective in black and 
white.  Scenes depicting squalor and misery 
can achieve most attention when presented 
in monochrome. Photojournalistic 
undertakings will be quite effective in black 
and white.   If a geographical location is 
important to the story in the picture, it is 
necessary to show parts of the area. 

It is a good idea to look at black and white 
photographs in magazines and books.  
Three black and white photographers of 
interest could be Ansel Adams for his 
wonderful landscapes, Don Mc Cullin for his 

documentary photographs and David Alan 

Harvey who photographed the Wyeth family 

for National Geographic. 

Hopefully, this issue of Viewfinder will 

inspire you to delve into black and white 

photographic undertakings.  Have fun 

experimenting in the monochromatic world! 
                                                                                    

HAPPY THANKSGIVING!!!  
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Black & White  
 Barry Goldstein 

When we speak about fine art 
photography, black and white 
photography comes to mind. It is 
somewhat vexing therefore, that  
during the 2009-10 SCC season, only 
7 members in Group A and B 
combined, entered black and white 
photogrpahs in 6 or more 
competitions. When this issue was 
discussed at our last Board meeting, it 
was suggested  that perhaps the 
problem is a lack of confidence 
regarding the process of producing a 
good black and white print.  If that‘s 
the case gentle reader, we will take 
care of that right now. 

The inclusion of color in a photograph 
is a layer of complexity not always 
necessary or desireable. This is a  
good example of the ―more is less‖ 
concept. Ansel Adams, an icon of 
black and white photography 
produced thousands of color 
photographs as well, but he was 
disattisfied with the level of control 
over the image as compared with his 
black and white work.   Now, 
Photoshop and other programs offer 
an incredible degree of control in 
black and white. Had Adams lived in 
the digital age, things may have been 
different, but he once likened working 
in color to playing an out-of-tune 
piano. 
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The first thing one must do to become proficient in black and white, is 
to learn to see monochromatically (witout color). To do that, look at 
the scene and ask yourself if the colors add to the composition or 
detract from it. If you have a red filter, try viewing your composition 
through it. The filter will absorb all colors except red giving you a 
monochromatic view of the scene. It‘s not black and white but it is a 
great help. 

For the few purists among us, there exist 
programs dedicated to Black and White 
printmaking such as Silver Efex Pro. Whether or 
not these programs are significantly better or not 
is a matter of preference.  The incredible amount 
of control that exists in the all purpose programs 
such as Photoshop leave little to be desired. 

Before you even start making black and white prints you should be familiar with 
rules. Rule 1 is that every print should have at least one area of absolute white 

and at least one area of absolute black. Rule 2 is that there are no rules. In fact, the lack of deep 
blacks and absolute white can enhance the mood of some images, and protraits of children and 
adult females are generally ―high key‖ meaning that their histograms tend toward the right. 

When converting a color file to black and white, you will be doing a fair amount of pixel manipulation, 
so starting with the extra information inherent in the RAW format is a no brainer.  

Outlined below are methods of black and white conversion using Picasa, Lightroom, ASDSee and 
Photoshop. Mac users using Iphoto are on their own; not due to any discrimination on my part, but 
lack of knowledge. 

B&W with Picasa  
Photoshop remains the ‗gold standard‘ for B&W conversion, but not everyone can, or is willing to 
spend that kind of money.  While conversion to black and white using Picasa does not have all the 
‗bells and whistles‘ of Photoshop, it can be done quite effectively. The main advantages of using 
Picasa are that it is simple to use and it‘s free. 

To convert a color image to B&W, just open the ―Effects‖ tab and click on ―Filtered B&W‖. The image 
will immediately change to B&W. You can stop there, but don‘t. Click on the ‗Pick Color‘ box to 
expand it. The mouse pointer will turn to a dropper and allow you to choose a filter color from 
panoply of colors displayed in the box. As you move the dropper, the image on your monitor will 
change. Stop when you are satisfied with the result. 

A live histogram will simultaneously show you the distribution of tones.  

B&W with ACDSee 

USING THE ACDSEE GRAYSCALE TOOL 

Like the simple desaturation methods in other programs, the grayscale tool tends to produce a 
relatively flat image in the midtones, but here‘s how to use it. 

Click the Selection Tool and click the photo.  

Click Adjustments | Color | Grayscale.  That‘s it.  

USING THE ACDSEE SEPIA TOOL 

―One sees differently 

with color photography 

than black and white...in 

short, visualization must 

be modified by the 

specific nature of the 

equipment and materials 

being used‖ 

–Ansel Adams 
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This method is similar to the Grayscale Tool except that it adds vary amounts of sepia tint. To use it: 

Click the Selection Tool and click the photo.  

Click Adjustments | Color | Sepia.  

Click the Black & White Photo checkbox.  

Drag the Age slider back and forth until you are happy with the effect.  

USING THE ACDSEE THRESHOLD TOOL 

The Threshold Tool will produce a high contrast ―litho‖ type of image, not a continuous tone image. It 
is useful only as a special effects method. 

Click the Selection Tool and double-click the photo.  

Click Adjustments | Light | Threshold.  

Drag the Threshold slider to the left to make more pixels white and to the right to make more pixels 
black.  

B&W with Lightroom 

USING GRAYSCALE CONVERSION IN LIGHTROOM 

This is the down and dirty method. In the develop module, directly below the 
histogram, the grayscale conversion button is located in the ―Basic‖ view. The 
grayscale option can be achieved by simply clicking ―Black & White‖. Typically, 
this particular grayscale conversion produces a black and white image with flat 
mid-tones. You will want to adjust your contrast for more variation.  

USING GRAYSCALE MIX IN LIGHTROOM 

The Grayscale Mix is found below the ―Basic‖ and ―Tone Curve‖ views.  

Click the ―B&W‖ button next to the ―HSL‖ and ―Color‖ buttons. Similar to the Black 
and white adjustment layer in Photoshop, this control converts the image into 
grayscale tones, but allows you to adjust each color tone individually. Play 
around with these adjustments until the tones are most balanced and pleasing.  

This is probably your  best alternative if you are using Lightroom. 

 

USING SPLIT TONING IN LIGHTROOM 

Beneath the ―Grayscale Mix‖ views is the ―Split Toning‖ option. This type of 
conversion is one of the most involved.  Adjust the slider to set your highlight 
color and saturation level, and then do the same with your shadows. From here, 
adjust the balance of between highlights or shadows. You will find that at this 
point, your image is not in black and white, it is in whichever colors you have 
chosen as your shadows and highlights. From here, you will need to go back to 
the ―Basic‖ option, where you will adjust the vibrancy and saturation of the overall 
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image. As you adjust these sliders, your image will become black and white with prevalent tones 
from your split toning. 

Black and White with Photoshop CS5 
There are at least a dozen ways to covert a color image to back and white in Photoshop.  The most 
obvious but least effective way is to use the Grayscale Mode to discrard the color information. This 
method can be effective but when one compares the result to other methods, it is obviously inferior.  

THE CHANNEL MIXER 

the Channel Mixer can be used to make a fine Black and White print with not much effort.  The 
channel mixer allows you to control how much each of each of the red, green and blue channels 
contribute to the grayscale brightness.  In Photoshop, you open the Channel Mixer by clicking on 
Image > Adjustments > Channel Mixer.  Be sure to first click on the Monochrome box, and then 
adjust each of the red, green and blue sliders to produce an image to your liking.   

Theoretically but not mandatory, the sum of the red, green, and blue percentages should equal 100 
in order to maintain constant brightness, although overall brightness can also be adjusted by using 
the "Constant" slider at the bottom. To mimic the luminosity perceived by the human eye, set: 
red=30%, green=59% and blue=11%.  

HUE – SATURATION ADJUSTMENT LAYER 

Here is one you may not have tried. 

Open the image in Photoshop and create two separate 
"Hue/Saturation Adjustment Layers" by following the menus: Layers 
> New Adjustment Layer > Hue/Saturation.  

On the top adjustment layer, set the blending mode to "Color" and 
the saturation to its minimum of "-100.‖  Note: the top layer in this 
illustration has been renamed from Hue/Saturation to Saturation. 

On the bottom adjustment layer, move the "Hue" slider to apply an 
infinite spectrum of color filters.  You will be amazed at the amount of 
control and ease of use for getting first class results. 

Once all adjustments have been made, flatten the layers to make the 
adjustment final or save it as a .psd for future adjustment.  

LIGHTNESS CHANNEL IN LAB MODE 

LAB is an acronym for luminance, A (red-green) and B (blue-yellow). This method is Scott Kelby‘s 
favorite.   

In Photoshop, first convert the image into the LAB color space by clicking on Image > Mode > Lab.  
Open the Channels pallet and view the "Luminance" channel by turning off both the "a" and "b" color 
channels. This is done by clicking on the ―eye‖ in front of each of them. Once the a and b channels 
have been turned off, the lightness channel will be the only channel, leaving a black and white 
image. 

You no longer need the a and b channels, so discard them by going to the image menu and 
selecting the Grayscale mode.  

If you want to darken the image, duplicate the layer (ctrl-j) and set the blending mode to multiply. 
Use the layer opacity slider to get the exact tone that you want. To make it lighter, change the 
blending mode to Screen and use the opacity slider the same as above. 
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COLOR PRINTS 'A'     

25 POINTS      

Marty Silverstein  'Ox Bow Bend At  Dawn' 

24 POINTS      

Valeri DeBiase  'Execution Rock Lighthouse'    

Dennis Madigan  'Lips Of An Angel'   

23 POINTS      

Ira Scheinerman- -'Scratch Here'     

Ed Starling-  -'Takeoff'      

COLOR PRINTS 'B'   

24 POINTS      

Chris Ferrara-  -'Secret Paradise'     

BLACK & WHITE  'A' 

25 POINTS      

Dennis Madigan-  -'Prison Wedding'     

Ira Scheinerman-  -'Daddy'      

23 POINTS      

Alan Agdern-  -'Flower Abstract 1'    

BLACK & WHITE  'B' 

23 POINTS      

Peter Metzger-  -'Side By Side'    

TOP SCORES DIGITAL 'A'    

23 POINTS      

Marty Silverstein-  -'Osprey At Dusk'    

Judges - Joanna Gazzola Dennis Golin Mike DiRenzo

 PFLI Scores for November

DESATURATE COLORS 

Desaturating the colors in an image is a simple of conversion, but often produces inadequate 
results.  This is because it does not allow for control over how the primary colors combine to produce 
a given grayscale brightness.  Despite this, it is probably the most commonly used way of converting 
into black and white.  In Photoshop, this is accomplished by going from Image > Adjustments > 
Desaturate. 

NB: Any SCC member who uses this method should immediately have his or her membership 
revoked.  

BLACK AND WHITE ADJUSTMENT LAYER 

I saved this one for last, fearing that if I used it 
first, you would not read the rest. If you have CS5 
it makes sense to just use this one. It‘s really quite 
simple.  

Click the new adjustment layer icon on the Layers 
Pallet and select black and White.  You will see a 
slider for each color although the image on the 
screen will be black and white. Moving the sliders 
changes the brightness of each underlying color in 
shades of gray to produce an incredible range of 
possibilities. For example to darken a blue sky, 
just move the blue slider to the left. Watch the 
image on your monitor closely as you change the 
default positions of the sliders. Enjoy! 

OTHER CONSIDERATIONS 
Ordinarily the best results are achieved when the 
image has the correct white balance.  Removal of 
color casts means that the colors will be more 
pure, and so the results of any color filter will be 
more pronounced. For that reason among others, 
one should first do levels adjustment to correct the 
histogram as well as the white balance. 

Any black and white conversion which utilizes a 
significant boost in color saturation may begin to 
show artifacts, such as increased noise, clipping 
or loss of texture detail.  On the other hand, higher 
color saturations also mean that each color filter will have a more pronounced effect. Moderation is 
therefore called for. 

Shoot in RAW mode if possible, as 16-bit images allow for the smoothest grayscale tones and the 
greatest flexibility when using color filters.  This also provides the ability to fine-tune the white 
balance based on the desired black and white look. 

The noise levels in each color channel are radically different. The blue channel has the most and 
Green has the least. Therefore, use the blue channel adjustments with care to avoid excess noise. 

Levels and curves can be used in conjunction with black and white conversion to provide further 
control over tones and contrast.  Keep in mind though that some contrast adjustments can only be 
made by choosing an appropriate color filter, since this adjusts relative contrast within and between 
color regions.  Care should also be taken when using these because even slight color clipping in any 

http://www.cambridgeincolour.com/tutorials/white-balance.htm
http://www.cambridgeincolour.com/tutorials/levels.htm
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December  

9th Competition- judged 
by Ken Bausert 

16
th
 Baby and Portrait 

Photography- Danielle 
LeMay 

23rd "Focus Modes" – 
Gerald Woulfin 

January 

13th Competition- judged 
by Dick Hunt 

20th "Travel Photography" - 
Ivan Rothman 

27th "Camera Modes" - 
Doreen Rose 

February 

10th Competition- judged by 
Joe Senzatimore 

17
th
  Scenic Spots on Long 

Island- Jane  Leek 
24th "HDR: - Valerie 

DeBiase 
March 

10th Competition judged by 
Andrew Kirchey 

17th "Portraiture" - Gerald 
Appel 

24th "Light & White 
Balance" - Alan 
Agdern 

April 

14th Photojournalism 
Theme Competition- 
judged by Leon 
Hertzon 

28th "Flash Photography"  
Marty Silverstein 
and Critique 

May 
12

th
  EOY Competition 

judged by Ed 
Sambolin, JoAnn 
Gazzola,  

19th  "Macro 
Photography" - 
Harvey Augerbraun 

June 
  End of Year Dinner 

of the individual color channels can become quite apparent in black and white (depending on which 
channel(s) is/are used for conversion). 

Getting it right on the computer is half the battle. This subject is too 
involved for this article, but understand that printing in pure black and 
white without color casts (most commonly magenta) can be a 
challenge unless you have a top notch printer or a printer that has 
separate inks for color and black and white printing. 

Stieglitz, Steichen and Strand 
Three great Black and White Photographers at the 
Metropolitan Museum of Art 
 

November 10, 2010–April 10, 2011 

This exhibition features three giants of black and white photography 
whose works are among the Metropolitan's greatest photographic 
treasures.  

Alfred Stieglitz, a photographer of supreme accomplishment as well 
as a forceful and influential advocate for photography and modern art 
through his gallery "291" and his sumptuous journal Camera Work, 
laid the foundation of the Met's collection. He donated twenty-two of 
his own works in 1928—the first photographs to be acquired by the 
Museum as works of art—and more than six hundred by other 
photographers, including Steichen and Strand, in later decades. 
Featured in the exhibition will be portraits, city views, and cloud 
studies by Stieglitz, as well as numerous images from his composite 
portrait of Georgia O'Keeffe (American, 1887–1986), part of a group 
selected for the collection by O'Keeffe herself. 

Stieglitz's protégé and gallery collaborator Edward Steichen was the 
most talented exemplar of Photo-Secessionist ideas, with works such 
as his three large variant prints of The Flatiron and his moonlit 
photographs of Rodin's Balzac purposely rivaling the scale, color, and 
individuality of painting. By contrast, the final issue of Camera Work 
(1917) was devoted to the young Paul Strand, whose photographs 
from 1915–1917 treated three principal themes—movement in the 
city, abstractions, and street portraits—and pioneered a shift from the 
soft-focus Pictorialist aesthetic to the straight approach and graphic 
power of an emerging modernism. 

For Sale 
Hoodman H-RAV right angle finder with fitted case containing 
4 adapters for Canon 18mm and 22 mm eyepieces and Nikon 
22 mm rectangular and 22 mm round eyepieces.  New 
condition.  The finder can be switched between 1x and 2.5x for 
critical focusing and allows you to use your SLR at low angles 
without bending. $65.  Contact barry.goldstein@yahoo.com. 

http://www.metmuseum.org/toah/hd/geok/hd_geok.htm
http://www.metmuseum.org/toah/hd/pict/hd_pict.htm
http://www.metmuseum.org/toah/works-of-art/33.43.39
http://www.metmuseum.org/toah/works-of-art/33.43.38
http://www.metmuseum.org/toah/works-of-art/33.43.38
mailto:barry.goldstein@yahoo.com
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 PFLI Scores for October 
 

 

 Judges -  Art Inselsberger - John  DiNicola -  John Brokos 

BLACK & WHITE A   

Alan Ross Copenhagen Wind Mills 21 

Jules Weisler Indian Maiden 21 

Barry Goldstein The Window 21 

Valeri DeBiase Got Wood 22 

Ira Scheinerman Hooter 1 23 

Alan Agdern Pa Falls 72 22 

BLACK & WHITE B   

Frank Kirshenbaum Desert Scene 21 

Peter Metzger Foggy Day 24 

COLOR A   

Alan Agdern Falls 54 21 

Alan Agdern Light Before The Storm 22 

Ed Starling Ocean Beach Sunrise 23 

Marty Silverstein The Royal Family 24 

Ed Starling 911 Tribute Lights 24 

Ramesh Patwah Elephants 19 

Alan Ross Santa Margareta Strip 21 

Ira Scheinerman Red Sales 22 

Valeri DeBiase Two Bits 23 

Peter Metzger Peggy‘s Cove 24 

COLOR B   

Jules Weisler Puma At Rest 19 

Linda Volin Mountain To Mountain 20 

Al Herbst Lighthouse Reflections 21 

Chris Ferrara Farmhouse 1 22 

Sunhil Chhatpar Butterfly Rising 23 

Alice Langholz Reflection In Red 21 

PROJECTION A   

Gerald Woulfin My Babies 21 

Gerald Harrison Waiting And Watching 5404 21 

Marty Silverstein Oyster Catcher Express 23 

Carol Goldstein* Dogs Nose 23 

Jules Weisler Butterfly 1 23 

Ramesh Patwah Sunset 21 

Peter Newman Splash 22 

Barry Goldstein Women In A Crowd 22 

Ira Scheinerman Olivia 23 

Aileen Harrison 1861 Death Valley 23 

PROJECTION B   

Fred Stermann Winter Pattern 21 

Fred Stermann Out 21 

Scott Katz blacksmith 21 

SCC Scores October 
 
B&W PRINTS -AA  

Silverstein, Marty 10 POM 

B&W PRINTS - A  

Scheinerman, Ira  10 POM 

DeBiase, Valerie 9 

Volin, Linda 8 

Weisler, Jules 8 

Herbst, Al 7 

B&W PRINTS- B  

Metzger, Peter  10 POM 

Ettinger, Burton 7 

COLOR PRINTS- AA  

Silverstein, Marty 10 POM 

COLOR PRINTS- A  

DeBiase, Valerie 10 POM 

Patwa, Ramesh 9 

Starling, Edward 9 

Madigan, Dennis 8 

Metzger, Peter  8 

Scheinerman, Ira  8 

Markewitz, Moshe  7 

COLOR PRINTS- B  

Langholz, Alice 10 POM 

Ferrara, Chris 9 

Ettinger, Burton 8 

Monahan, Maylan 8 

Weisler, Jules 8 

Flagg, John 7 

Volin Linda 7 

Projection-AA  

Silverstein, Marty 10 POM 

PROJECTION- A  

Goldstein, Barry  10 POM 

Harrison, Gerald  9 

Weisler, Jules 9 

Ferrara, Chris 8 

Goldstein, Carol 8 

Harrison, Aileen  8 

Markewitz, Moshe  8 

Newman, Peter 8 

Patwa, Ramesh 8 

Woulfin, Gerald 8 

Bowie, Bill  7 

PROJECTION- B  

Sterman, Fred 9 POM 

Volin, Linda 8 

Rose, Doreen 7 


